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Another Perspective
By John Toutkaldjian
Photo Show Contest Chairman

T

his year, DPS has expanded its
traditional Photo Essay competition to include more diverse forms
of visual presentations. The contest
is also renamed to reflect that. It is
now Photo Show. The change was
made to encourage member participation and open up new avenues of
sharing photos.
The event is scheduled for Monday, April 28, 2008 at our usual
meeting time and place. This article is to remind you of the contest
and review some of the particulars.

A group of pictures is an exciting
and challenging way to express your
ideas, document a culture, describe
an event or simply share an experience; yes, and tell a story. Many
members of DPS found the photo
essay concept too restricting of
their interests in sharing their photographic experience and ideas. So,
for the most part, anything goes —
just make it interesting, stimulating
and enjoyable.
This is an opportunity to expand
creativity and experimentation, to
stimulate more than just visual
senses. Employing the sound fea(Continued on page 2)

Curious Glance by Julie Elliott
February high-scoring projected
image

Doug Miller Presents, Inner Vision
March 31 y 7:30 pm
Cokesbury Auditorium
Doug Miller, Salem,
Virginia, will present a program on
“Inner vision” —
the way to create
great images. Doug
believes that inner
vision has nothing
to do with the camera, or the sub-

Coming Events…

ject, but it is about feeling and
capturing that feeling. All photographs start with this inner vision.
He will discuss how to find and use
your own inner vision, why you take
a photograph, and what emotions
you are conveying to the viewer.
Doug started his own photographic company at age 16 and attended the Ohio Institute of Photography. He has worked for
numerous publications and on na-

March 2 — Second showing, 75th WIEP, Arsht Hall
Univ. of Del., Wilm. Campus, 2600 Penn. Ave.
March 3 — Digital Entry Deadline for 3/10/08
March 3, 7:30pm...Instruction Night (pg. 3)
March 10, 7:30pm...Projected Image Night

tional assignment for companies
such as, US Sprint, UPS, National
Geographic Society, Metropolitan
Opera, Getty Images, Target, Fed
X, Miller Brewing, and NASCAR.
Join us at 6 p.m. for dinner with
the speaker in a private Cokesbury
dining room. Reservations must be
made in advance to Bob Coffey at
bobcoffey@aol.com/610.388.2741.
Dinner cost is $16, all inclusive.
Sorry, no walk-ins. Limit 30.

March 17, 7:30pm...Print Night
March 24, 7:30 pm...Board Meeting
March 29, Field trip — Cedar Run Wildlife Refuge
March 31, 6pm...Dinner with Speaker
7:30pm, Doug Miller; Main Auditorium
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ture of a Photo Show can increase
the emotional impact of photography. The ability to move images, or
move on images, opens up another
avenue to test your creativity and
further arouse the viewer’s senses.
There are two categories, Print
and Projected Image. The Print
category has only one class. Projected Image has three classes and
includes slides and digital images
which compete together. You may
enter all four classes but with only
one entry per class.
Prints may be mounted on one
or more boards totaling up to 640
sq. inches (think of it as two 16"x 20"
boards). Projected Image Class 1
restricts the entrant to a maximum
of ten images and, in this case, the
Photo Show must tell a story.

Project Image Classes 2 and 3 are
only restricted by their length, up to
three and ten minutes respectively.
Judging will be based on two criterions — Presentation and Photography. Scoring will be by our familiar
system of 1 – 9 points awarded by
three judges.
More detail is provided in the
Rules and Entry Form available on
our Web site and also at meetings.
Please review these carefully.
Entry deadline is Monday, April 21.
Contact me at jmtout@comcast.net/
610.485.6774 (after March 5, call
610.358.1927) with any questions
relative to the competition and Ken
Seeney at seeneyk@comcast.net with
technical inquiries. See you at Photo
Show time!
See Preparing Images, page 8

Future WIEP Chair — Michael Elliott
610.274.8316 / gefeddo@aol.com
Field Trips — Tom Oathout
302.836.0148 /delawarefoto@yahoo.com

75th WIEP Opens to Large Crowd

Awards Committee — Herb Sargeant
302.731.4069 / hmsargeant@msn.com

½ Chairman Bob Hunt addresses a

Equipment Chair — Bob McKenney

packed house for the first showing of
the projected image presentation. For
the first time digital entries and slides
were combined in the same category.

302.368.2332 / bigstuart31@comcast.net
Publicity Chair — John Hamilton
302.479.0222 / deljohn@aol.com
Judges Chair — Tom Tauber
610.626.1579 / tetauber@comcast.net
Standards Chair — David Hutton
302.731.4815 / dgh36@mac.com
DPS Webmaster — Mark Reed
302.655.1439 / mark4reed@comcast.net
www.delawarephotographicsociety.org

The Delaware Camera Club (DCC) was
established January 28,1931. DCC is a
charter member of the Photographic
Society of America and The Delaware
Valley Council of Camera Clubs. In 2002
the name was changed to the Delaware
Photographic Society (DPS) and the Society became a tax deductible educational
organization.

½ Karl Leck’s ever-popular print
discussion examines the expertise
required to produce award-winning
images.
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Instruction Night Schedule

Vignettes

techniques. Do you want a portrait
to hang on the wall but cannot
afford a painter? Starting with a
photographic

I

nstruction Night Sessions are
held the 1st Monday of the
month in the duPont Pavilion.
Making Artsy Digital Images
At the March 3 Instruction Night
Karl Leck, aided by the audience,
will show some of the ways in
which digital images can be modified in the style of traditional art

portrait,

you

can

create a canvas effect image for
printing. Do you like to sketch
scenes? It's faster when you start
with a digital image. Would the
picture look better with a border
and you cannot afford extra software just to put a border on one
image? You can make the border
easily with the image software you
already have. Join us for the March
Instruction Night to learn more
about using filters and layers in
imaging software to create art.
y April 7: Digital Infrared — Karl
Leck et al
y May 5: Rain, Rainbows and Other
Natural Phenomena by Digital
Means — Karl Leck

Photoshop Elements Instruction
y A Special Interest Group (SIG) is
meeting to learn about Adobe Photoshop Elements (all versions) at
Edgemoor Community Center, 500
Duncan Rd., Wilmington in an interactive workshop. Sponsored by DPS,
it’s free to anyone and will continue on Tuesdays about twice a
month until May 27. Start time is
7pm and the open discussion ends
promptly at 8:30pm. For more information, contact Ruthann King at
raking444@verizon.net.
y Photoshop Elements Sessions
are also available at the Newark
Senior Center, Room 2, White
Chapel Dr., Newark, De, at 7pm. on
the second and fourth Tuesdays of
the month. For directions go to:
www.newarkseniorcenter.com/
Directions.htm and for information,
Dave Hutton at dgh36@mac.com.

•

is held the first
Monday of the month
at 7:30pm.

•

3

Competition nights are held on

the second and third Mondays at
7:30 pm.

•

Program night is the last Monday

of the month at 7:30 pm.

•

Location: Cokesbury Village,

DuPont Pavilion, 726 Loveville Road,
Hockessin, DE 19707. Guest speaker
programs are presented in the
Cokesbury auditorium.

•

Membership dues should be

addressed to: DPS Treasurer, John
Blankenbaker, P.O. Box 120, Chadds
Ford, PA 19317. Dues are $35 for
individuals, $25 for others at the
same address, and half the individual for junior or nonresident members. Dues for first–year members
are $20 per person.

•

y Bill Westerhoff, who taught our
“Introduction to Digital Photography” class at Edgemoor last fall, has
completed a new "Basics and Beyond" CD, which is available for $10.
It includes tutorials from prior editions, free programs, links, and a 74
page tutorial on Elements 6. Also,
there are instructions for downloading a free action, which allows you
to set up both curves adjustments
and layer masks. You will learn
about making selections, layers, layer
masks, color correction, and sharpening, among many of the topics
covered. Much of the information
will also be of value to those using
earlier editions of Elements. The
CDs are available at Edgemoor
meetings or by contacting Bill at
westerhoff@comcast.net.

Instruction Night

The Reflector is published by

the Delaware Photographic Society,
and printed by Academy Printing.
No material may be reproduced
without written permission. Contribution deadline is the third Monday
of the month. Send announcements
or articles to Sharon Coffey at 48
Partridge Lane, Kennett Square, PA
19348 or SESCoffey@aol.com.

•

DPS members are encouraged to

participate in our Yahoo group, DPSExchange. For information, go to
DPS-Exchange@yahoogroups.com

•

Visit our Web site at:

www.delawarephotographicsociety.org

This program is made
possible, in part, by grants
from the Delaware Division of the Arts, a state
agency dedicated to nurturing and supporting the arts
in Delaware, in partnership with the National Endowment for the Arts.
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Focus on Emily Reed

Eye to Eye by Emily Reed
DVCCC Medal, PJ Print,
75th WIEP

I

was born in South Bend, Indiana
and attended Marquette University in Wisconsin. Tom Reed, a Marine, and I were married in 1962
and shortly after moved to Camp
LeJeune, North Carolina. Although
my undergraduate degree was in
Political Science and Philosophy,
there were not many employment
opportunities for political philosophers in Jacksonville, North Carolina. So, I taught 6th grade in a
county school. When Tom left the
Marine Corps to go to Law School at
Notre Dame, I again taught grade
school. After Tom graduated, we
moved to Richmond, Indiana, where
I began graduate courses at Ball
State University. We also adopted
our two babies in Richmond — Martin in 1970, and Valerie in 1973. In
1976, we moved to Springfield,
Massachusetts where Tom became a
Professor of Law at Western New
England College. I continued in
graduate school and received a
Masters of Public Administration
degree from the University of Hartford, and a Ph.D. from the University of Massachusetts.
In 1981, Tom accepted a teaching position at the then Delaware
Law School, and we moved to the
Wilmington area. I began a varied
career of service in state govern-

ment and college teaching at night.
I worked for the Delaware Criminal
Justice Council for 10 years which
also got me into part-time teaching
of criminal justice at the University
of Delaware. I laughingly said that I
teach criminal justice, but I never
took a criminal justice course!
I have always loved electronic
gadgets, and throughout my work
years, I had frequently relaxed by
taking videos with a big VHS video
camera humped up on my shoulder.
I remember one fall taking a week
off work just to go around and film
trees and leaves!
This love of the technology (we
got our first personal computer in
1982) also got me my last job in
state government as a systems and
database administrator. I managed
Sun servers and Oracle databases,
both of which I had never even
heard of before I took this position!
My employers said that, since I had
so much experience with PCs, and a
Ph.D. degree to boot, they thought I
could learn it all — and so I did.
In 2001, I retired from state government and college teaching and
started to take art classes at the
University of Delaware’s Academy of
Life Long Learning and to dabble in
painting pictures. I wanted to do
something entirely different in retirement from what I had done in
my work life. I come from a family
of artists, so art seemed like a logical choice for fun and recreation.
Enticed by the interface of computers and cameras, in 1999 I purchased my first digital camera, a
Nikon Coolpix 950. It is a quirky
thing with a hinge in the middle to
swivel the lens portion into position.
With this camera in 2004 I commenced taking pictures of my paintings to load on my website
4

www.artwanted.com/DrEmilyR.I
now have 1,900 images there. I also
started sending photos to the News
Journal “Photo of the Week.” Low
and behold, they published them.
My career as an amateur photographer was launched!
The Coolpix 950 stood by me for
a half dozen years, but its 2 megapixels eventually proved inadequate
for the Internet, and the 3X optical
zoom couldn’t capture that bald
eagle in the distance. So in 2005, I
replaced it with a Nikon Coolpix
8800. This point and shoot camera
has 10X digital zoom, and I added a
TC-E17ED telephoto lens that really
put me in business for capturing
distant birds and other wildlife.
Unfortunately, though, the really
long shots proved to be grainy and
unusable for publication. In 2007 I
moved up to a Nikon D200. Digital
SLR was the logical next step. And
just this past month, I completed my
upgrade with a Tamron 200-500mm
telephoto.

In 2005, I began to enter exhibits
at various local art associations in
the area. Low and behold — both
paintings and photos won prizes!
Now, I was really sucked into visual
arts big time. Several of my artist
friends, especially
Jerie
Kunitsky,
had been urging
me to join the
Delaware Photographic Society,
and to enter their
Wilmington International Exhibit of Photography. So,
in September, 2007, I did join. And
in January, 2008, three of my photos were accepted in the WIEP. Two
even won prizes! What an honor!
I guess I’m hooked for good into
photography. Z
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Field Trips y Adventures
y Cedar Run Wildlife Refuge in
Medford, New Jersey will host ten
club members Saturday, March 29
from 10 a.m. to 12:30p.m. There
will be a minimum donation of $10
per person. We will leave by
8:30a.m. and will try to arrange car
pools to share gas and toll costs.
Anyone interested in participating,
please contact Lynn Maniscalco at
Ltmphoto@juno.com to reserve
space. If there is enough interest,
we can schedule a subsequent trip
in the future.
y A trip to scenic Dolly Sods, West
Virginia is being planned for May
16-18. Hiking trails lead throughout
the sods among laurel and blueberry
thickets to cliffs along the front
that look eastward over the valley
of the South Branch Potomac River.
This slice of the Monongahela Nat.
Forest has nearly everything from
rocky vistas, open glades, thick
spruce, northern hardwood forests
to a deep canyon cut by Red Creek.
May promises to be a beautiful time
to visit. Check out the following
Web sites: www.fs.fed.us/r9/mnf/
sp/dolly_sods_wilderness.htm and
www.wv.gov. For information, contact Tom Oathout at 302.836.0148
or delawarefoto@yahoo.com.

Studio Lighting

y An organizer is needed for the
April 12 field trip to Baltimore. If
you are familiar with the Inner Harbor area and would be willing to
help, contact Lynn Maniscalco at
Ltmphoto@juno.com.
y Another DPS cruise adventure is
planned to Canada and Quebec
from October 9 - 18, 2008, aboard
the Explorer of the Seas. This 9-day
round-trip voyage will depart from
Cape Liberty, NJ with stops in
Sydney and Halifax, Nova Scotia,
Charlottetown, Prince Edward Island,

Saguenay River, and Quebec City. If
you are interested in joining us, get
your deposit in as soon as possible.
There's a Royal Caribbean International customized flyer waiting for
you! Copy and paste the link below
into your web browser's address
window and hit enter: http://

Portrait and Studio Lighting
Seminar and Photo Shoot will be
held from 9 a.m. to noon, on Saturday, April 5, in our regular

Cokesbury meeting room. Ray Firmani will conduct a seminar, demonstrating professional portrait
lighting, character study and model
photography lighting.
Different types of lighting, as
well as portrait and model posing
tips, will be demonstrated, after
which, members can take photographs of the models, and move and
set lamps, to explore different
lighting situations. Members should
bring their camera, cable release,
and tripod because the studio lighting will necessitate the use of slow
shutter speeds.

www.cruisingpower.com/
CruiseWriter/asp/flyer_print_RCI.asp?
documentid=5%2F%4089%2C1%2F%
3A2%3F31%2FB3%3F3%3D.

For more information, contact Gus
Teipelke at gttraveler@comcast.net
or 610.444.8647. Gus will also be
available to answer your questions
at Arsht Hall on March 2 during the
WIEP exhibition.

Assigned Subjects
March — The Decisive Moment
April — Less is More

Call for Presenters and Judges

T

he Delaware Council of Camera
Clubs (DVCCC) is in the process
of updating its list of presenters and
judges. It has been some time since
the list was published and it is outdated. An updated version will be
made available on DVCCC's Web site
at www.dvccc-photo.org.
Anyone who is interested in being
included please contact Ken Sichel,
26 Oriole Place, Laurel Springs, NJ

08021; kenjcc01@aol.com ; or
856.627.5831 with your contact
name, mailing address, phone number, and e-mail address.
For Speakers Questionnaire send:
y Available Program Title with Program Type (How to, Travelogue,
Nature, demonstration)
y Slides, Multimedia Digital, Prints
y Fee ($ or Call)
y Travel (Distance limitation, Days
5

Only Y/N, Other Limitations
For the Judging Questionnaire
y Prints Y/N
y Slides (Pictorial Y/N, Nature Y/N
Digital Images Pictorial Y/N,
Nature Y/N)
y Fee ($ or Call)
y Travel (Distance Limitation, Days
Only, Other Limitations)
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Questions & Answers

Is keeping slides in Carousel
Q :trays
problematic? Several of

before cleaning. If fungus has attacked the gelatin layer, the cleaning options are limited. One of the
useful techniques to remove fungus
is an exposure to sunlight. This
technique works well on fungus in a
lens but may cause a noticeable
fading of the slide.
The storage of digital images
has no fungus problem whatsoever.
I have an external hard drive and
gold plated CDs. However, I have
some old floppy disks as well and no
drive to read them. In less than ten
years digitally stored information
has become unavailable. The uncertainty of digital storage is a more
serious problem than fungus.

my slides show a growth of mold,
although the trays are being kept
in a cool dark room.

New DSLR cameras exhibit
Q :very
little noise at high ISO

Contributed
monthly by
Erik Kissa

For more information on photographic
equipment and techniques visit me at
www.psa-newmember.org, open
Consultation Services, and click on
Exploring Equipment and its Use.

A

:Humidity promotes the
growth of mold. I do not have
a mold problem because my house
is air conditioned and the humidity
is low. My oldest slides stored in
steel slide boxes are 56 years old.
Kodachrome slides are still good.
Anscochrome slides have faded noticeably but are still useable. Ektachrome slides have faded badly and
are now useless. Slides stored in
polypropylene slide pages for 20
years have not faded. Some Kodachrome slides stored on carousel
trays have faded noticeably but can
still make good prints. Intuitively I
feel that storing slides in trays is
the least desirable storage mode
because the cardboard boxes housing the slides are hygroscopic.
If fungus has attacked the protective lacquer of the slide, the
fungus and the lacquer can be removed with a solvent. The slide
must be removed from the mount

values. Are wide aperture
(“fast”) lenses still needed?

A

: Fast constant aperture
lenses extend the limited
light photography and have a shallow depth-of-field useful for separating the subject from the background. The wide aperture enhances the speed of autofocus and
a constant f number allows incident
exposure metering.
For cameras with a 35mm frame
size the pros prefer the duo of the
28(35)-70mm/2.8 and the 70(80)200mm/2.8 zoom lenses. The corresponding focal lengths for the DX
(APS-C) format are the 18-55mm
and the 50-135mm lenses. The
Sigma DC 50-150mm/2.8 HSM lens is
light (1.7 lb vs. 3.2 lb of the 70200mm lens) but the lens is soft at
the long end and does not have stabilization. The optically very good
Tokina 50-135mm/2.8 lens lacks
optical stabilization. Hopefully,
6

Nikon or Canon will introduce for
this focal length range a stabilized
lens with an outstanding optical
performance.
it true, that increasing
Q :theIs number
of pixels in a sensor increases noise in the images?

A

: If the electronic interaction
between the photosites is the
only factor determining noise, then
the answer is a qualified yes. All
sensors of the same size are not the
same, however, and photosites can
be different.
When the output of the image is
in JPEG format, in-camera processing includes noise reduction. The
loss of sharpness caused by noise
reduction is minimized by sharpening. As a consequence, the noise in
the image does not necessarily increase with increasing number of
pixels. As an example, the Canon IS
700 and the IS 850 pocketable P/S
cameras are identical, except for
the sensor and the processor. The
IS 700 has a 6 MP sensor, and the IS
850 has a 8 MP sensor. Quite unexpectedly, the IS 850 has less noise
and appears to be at least as sharp.
All P/S cameras produce images
in JPEG format and have in-camera
processing. DSLR cameras and some
digicams use RAW format as well
which has no or very limited processing. The noise reduction and
sharpening of the RAW format images are left for the photographer
to do. Therefore, the effect of the
number of pixels on noise is more
evident in RAW format than in JPEG
format images.

(Continued on page 7)
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Questions & Answers
(Continued from page 6)

I damaged my camera by
Q :inserting
the memory card
improperly and sent it to the service department of the camera
manufacturer for repair. When
the camera was returned, it did
not work, although I was very
careful to insert the memory card
properly. The service department
claimed that the camera had
been repaired but I had damaged
the camera again. A second payment was requested for the second repair. A discussion with the
rep of the service department did
not go anywhere. Is there something I can do?

A

: Although this is an incredible situation, a confrontation
is unlikely to be productive. A better approach would be to discredit
the service department with questions: How was the camera inspected before shipping? May I
speak with the technician who repaired the camera? May I speak
with the manager? A letter to the
manager of the service department

may help. If you are a pro or a semipro, we can get expedited service
but getting a ruling in your favor
may take time.
The trouble can be avoided by
buying the camera from a local
dealer. When the camera breaks
down, the dealer will ship it to
have it repaired. When the camera
comes back, the dealer will demonstrate to you that the camera has
been repaired properly. If the repair is unsatisfactory, the camera
will be shipped back but you will
have nothing to worry about.
Are there any Nikon DX
Q :lenses
you would recommend?

A

: I have the Nikon DX 1224mm/4.0 wide angle lens.
Although the lens is good, the Tokina PRO 12-24mm/4.0 has slightly
less distortion and better resolution
for a much lower price.
The best Nikon DX lens is probably the 17-55mm/2.8 zoom. I was
planning to buy this lens but decided in favor of the Sigma DC 1850mm/2.8 HSM lens. (The Nikon
version of the lens with the HSM

motor costs $90 more than the lens
without HSM). The Sigma lens has
even better resolution, less light
fallout, and closer focusing
(“Macro”), all this for half the
price. The lens is very sharp and is
my favorite for landscape and night
photography. The lens is available
with Canon mount as well.
The Nikon 18-200mm/3.5-5.6 VR
lens is a very popular travel lens.
Some photographers love this lens.
Other photographers recognize its
optical limitations but like the convenience of the 11x zoom. Most of
the Nikon 18-200mm lenses have a
zoom creep which can be annoying,
especially when the lens is on a
tripod.
Nikon has made some inexpensive
DX lenses with surprisingly good
optics at a low price: the 1855mm/3.5-5.6 VR ($200) and the 55
-200mm/4.0-5.6 VR ($230) zooms.
The lightweight construction of the
lenses excludes heavy duty use.
Erik Kissa

Send questions to ekissa@aol.com

Horizon Workshop Summit

S

teve Gottlieb, founder, director, a Instructor of Horizon
Workshops, will hold the third
“Annual Photography Summit” on
May 2, 3, and 4, 2008 at his studio
in Chesapeake City, Md. The threeday weekend program will consist
of lectures by Horizon faculty and
other leading photographers such as
Jim Clark, Howard Millard, David
Handschuh, Diane Shapiro, Hakaan

Diker, and DPS’s own Karl Leck and
Bob Coffey. Also, there will be portfolio reviews, photo competition
with great prizes, field trips with
Horizon faculty, and personal shooting time in scenic, historic Chesapeake City. For highlights of courses
and description of the individual
sessions visit the Horizon Web site
at www.Horizonworkshops.com.

7

2008 International
PSA Conference
Portland, Oregon
August 31 — September 6, 2008

The Reflector

March 2008

Preparing Images for Photo Show Contest
Contributed by Bob Coffey

Unlike slides, the digital images
downloaded from your camera or
scanned from film are not “What
you see is what you get”. They need
to be optimized exposure, brightness, contrast and color, then resized, converted to sRGB profile
and sharpened to reproduce on the
screen what you saw through the
viewfinder. These steps can be accomplished to varying degrees with
many of the image editing programs, including ProShow Gold.
The most important step is to
calibrate your monitor with a colorimeter such as a ColorVision Spyder
(www.colorvision.com).Prices range
from $79 for the Spyder2 Express
to over $200 for the Elite model,
but one of these will give you the

biggest bang for your buck, not just
for projected images but in making
prints that match what you see in
your monitor.
The following is an abridged version of the protocol followed by the
“scanner corps” in preparing images
for the WIEP projected image show.
It was prepared using Photoshop
CS3, but Photoshop Elements and
other editing applications can emulate the steps.
y Crop the image as desired. Adjust
the exposure, contrast and color
using Levels, Curves and Hue &
Saturation and other adjustments as
needed. Avoid blown highlights.
y Go to Image>Image Size set the
Pixel Dimensions as follows:
Horizontal— For PhotoShow competition set the width to 1024 pix-

y Go to Edit>Mode>Convert to Profile
and select sRGB (sRGB IEC61966-2.1")

Sharpen the image with Unsharp
Mask, Smart Sharpen or similar
sharpening feature. Go to File>Save
As and type the File Name. Use a
numerical sequence, (001, 002, 003,
etc), otherwise the computer will
sort the files alphabetically. Select
JPEG as the format and save all images into a separate file. Start at a
Quality setting of 12, then move the
slider so that the final compressed
Size is between 300 and 500 KB.
Note: For the Photo show competition there is no limit on file sizes.
The images are now ready to be
inserted into Pro Show Gold or a
similar presentation program. Now
it’s show time!

Seminars
On April 12–13, Joseph Van Os
Photo Safaris is offering a week-

end nature and digital photography
seminar with John Shaw — nature
photography on Saturday and digital
workflow and Photoshop on Sunday.
It will be held at the Tremont Grand
and Conference Center, Baltimore,
MD from 8:30am – 4pm at a cost of
$160 for one day, $225 for the
weekend (add $20 to pay at door).
To register contact 206.463.-5383 or
www.photosafaris.com.

Sheppard, and Michael H. Francis.
For more information or to register
online, go to www.nanpa.org.

y NANPA Road Show

The North American Nature Photography Association (NANPA) 2008
Road Show is coming to Wilmington,
May 2 - 4, at the Doubletree Hotel
Downtown. This year’s professional
instructors will be Richard Day, Rob

Thank you for supporting our sponsor.
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Member News
y WIEP Results are in. Thirty-four
DPS members received acceptances,
and 16 of the 75 medals and 8 honor
ribbons went to DPS members. Congratulations to the following people
for their achievements in Color
Print (CP), Monochrome Print (MP),
Small Print (SP), Projected Image
(PI), PJ Projected Image (PJ PI),
and PJ Print (PJP): Steve Berkowitz (SJCC Gold Nature PI), Tom
Canby, Dianne Carnegie, Susan
Clark, Bob Coffey, Gus Costis,
Patsy Costis, George Eichner, Michael Elliott, Nancy Everds, Ray
Firmani, Helen Gerstein (IIWF
Gold MP), Marvin Gerstein (DPS
Silver CP, DPS Bronze CP, DVCCC SP,
HM CP), Allistair Gillanders
(DVCCC, MP), John Hamilton, Bob
Hunt (HM MP), Dave Hutton, Karl
Leck (PSA Mid-Atlantic Gold PJP,

DPS Silver PJP, DVCCC PI, HM MP),
Lynn Maniscalco, Monica Nagy,
Tom Oathout (DPS Silver SP,

DVCCC PJ PI, HM MP, HM SP),
Christine Oehl, Karen Pentz,
Bronze
Emily
Reed(DPS
PJP, DVCCC PJP), Mark Reed,
Marty Reed, Herb Sargeant, Jeff
Smith (HM MP), Jane Strobach
(DVCCC CP), Bill Talarowski (PSA
Gold MP, HM MP), Tom Tauber,

Mickey Turnbo, John Toutkaldjian (DPS Bronze PI), and Rob
Tuttle (HM MP).

y Lynn Maniscalco was awarded
her PSA Gold Editorial medallion at
our WIEP judges' banquet since she
was unable to attend the PSA conference in Tucson last September.
The award signifies an accumulation of 1000 editorial points for articles published in PSA Journal,
ranging from two for a short item to
40 for a cover story.
Also, Lynn was awarded an engraved tray in honor of her 2007
designation as Senior Fellow WIEP.
This distinguished award signified
100 WIEP acceptances. There have
only been eight other Senior Fellows in the history of the Wilmington International. DPS members Bill
Talarowski and Karl Leck also hold
this honor.
y On February 19, Lynn Maniscalco
presented her show, Storytelling
Images to the Coral Springs, Florida
Camera Club.
y Steve Berkowitz has won the
Photocon Best Pet or Animal photograph contest in Horse of Delaware
Valley magazine.

Barrington Fishing Shack
PSA Gold Medal, Monochrome Print
by Bill Talarowski, as depicted in a
circa 1925 Rulex. Image by Bob Coffey

A commemorative booklet has been
prepared for the diamond anniversary of the WIEP. Read how the
exhibition has evolved over seven
and a half decades. This historical
review will be available at meetings
for $3 per copy.

WIEP Judge Joins DPS
Lynn Maniscalco received this following note from Gisela Kahn, WIEP
judge and January speaker from
Cuxhaven, Germany. We appreciate Gisela’s kind words and insight
into the 2008 judging. She was so
impressed with DPS that she has
joined our club!
Back to Germany, nice memories
of the 75th Wilmington judging are
left. Not only meeting and getting

to know people but also the judging was very interesting. The ambience in the location was excellent.
While we (the 3 judges) were sitting in the dark the presentation of
the photos in the enlightened rectangle was perfect. After having
given our choice we heard the
result immediately and never differed too much. There was almost
a unique voting...It was obvious
that so-called organized photos had
9

little chance. Might it be long
shadows along the dunes, old men/
women with kids and when it
showed up that Photoshop was
used too much. The ideas behind
the photos were important and
those pictures — monochrome or
color — were successful. Thank you
once again for having asked me it
was a great pleasure.
Dankeschön
Gisela
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Exhibits

Contest

y Frida Kahlo: Through the Lens
of Nickolas Muray will be on view
at the Delaware Art Museum
through March 30. The exhibit features nearly 50 photographs of
Kahlo.
y The Philadelphia Museum of Art is
presenting Frida Kahlo through
May 18, an exhibition of more than
40 of Kahlo’s most important selfportraits, still lifes, and portraits,
plus nearly 100 photographs of
Kahlo and Diego Rivera. For more
details on both exhibits go to
www.delart.org.
y Elisabeth Bard will exhibit her
photographs on April 18 at the
Biggs Gallery in Dover.

National Wildlife Federation
(NWF) 2008 Photo Contest. Cash
prizes totaling $18,000 plus camera
equipment and other gifts will be
awarded to the winners in three
separate divisions: professional,
amateur and youth. The grand prize
winner will receive $5,000. Plus, a
portfolio of award-winning entries
will be published in the 2008
December/January issue of National
Wildlife Magazine. The $15 entry
fee also entitles entrant to receive
a one-year NWF membership. Submit as many as 20 images in any
combination of six categories.
The submission deadline is July 1,
2008. For information on the categories and how to submit your photos, refer to the official rules at:
www.nwf.org/photozone

The Photographic Society of
America (PSA) is the largest
organization of its kind in the
world, bringing together amateur
and professionals in all the varied
fields of photography, including
color slides, nature, pictorial
prints, stereo (3D), electronic
photography, video/motion
pictures, photojournalism, travel
photography, and devotees of
every process in which the worldwide membership is interested.
Help from experts and educational programs is available to all
members. Find out more about
the PSA from these websites:
www.psa-photo.org and
delawarephotographicsociety.org.

Wacom Intuos
Special Edition
Graphics Tablet 9x12 with
Intuos pen and 4D mouse.
$375
Contact Bill
talarowskiw@aol.com

Autumn Reflection by Bill Talarowski
March high-scoring Color Open image
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